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Stufflt Classic User’s Guide

1. Introduction

What is Stufflt Classic ?

Stufflt Classic is a useful file archiving utility that allows you to do the following:

1. Gather many files together into a single “archive”.

Optionally compress those files.

Optionally generate a report of the entries in an archive.

Segment large files for transmission by modem or for archiving from a hard disk onto
floppies.

Create self-unstuffing archives.

Encode and Decode BinHex4 .hgx files.

UnPack Packlt II/I1I “.pit” files and optionally convert them to the Stufflt format.

Decode “optimized” files created with Stufflt Deluxe.
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Of course, Stufflt Classic also allows you to “UnStuff” files that have previously been archived
(or “stuffed”) by you or another user.

Stufflt Classic is the newest version of the long available Stufflt software. You will occasionally
see the words Stufflt and Stufflt Classic used interchangably. Since Stufflt was first available in
1987, it became an industry standard for compression and archiving. Early in 1990, Aladdin
Systems introduced Stufflt Deluxe, introducing many new features into the original Stufflt. A few
of these features have found their way into this 1.6 version of Stufflt Classic, so longtime users
of Stufflt may see some new, welcome additions.

The Stufflt Deluxe package also includes a comprehensive manual that is quite different from
what you’re reading now. In addition to a comprehensive reference section, the Stufflt Deluxe
manual includes scores of “hand holding” tutorials that beginning users may find easier to digest
than this User’s Guide. First time users may also find some of the features within Stufflt Deluxe
(such as “point and click” access from the Finder and a simplified menu structure) much easier to
use than the Stufflt Classic application.

Why use Stufflt Classic ?

Gathering many files into an archive allows you to transmit many files as one over a modem or
network. Compression of the files saves disk space and/or on-line time when transmitting or
receiving files by disk or modem. Compression of rarely used files will allow you to better
utilize available disk space.
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About the author

Stuftlt was written by Raymond Lau with the help of a few other people. Work on Stufflt started
around July-August, 1987 and has continued ever since. In April of 1989, Aladdin Systems
assumed all marketing and publishing responsibilities for the Stufflt family of products. Aladdin
is devoted to continuously improving and updating Stufflt Classic and we welcome your
suggestions, criticisms and other input.

Aladdin may be reached at:

Aladdin Systems, Inc.

Deer Park Center

Suite 23A-171

Aptos, CA 95003

408-685-9175

AppleLink: ALADDIN; Connect: ALADDIN; GEnie: ALADDIN.SYS; CompuServe:
75016,325; Internet: aladdin@well.uucp

What you need to use Stufflt Classic:

Stufflt Classic works on any Macintosh family computer with at least 1 megabyte of memory.
Stufflt Classic requires that you use System 6.0.2 (or later) and the corresponding Finder™.

What you need to know:

You should know generally how to operate your Macintosh, how to use the mouse and the
menus, how to open documents, copy files, install applications onto your hard disks, etc. This
manual assumes you are familiar with using the Macintosh and the basic terminology associated
with that usage. If you need help in this field, please consult the manuals which came with your
Macintosh.

What constitutes the Stufflt Classic “package”:

The Stufflt Classic “package” consists of a single installation application called Install StuffIt
Classic. This application will install the following items on any hard disk:

Stufflt Classic, the application itself;

This documentation file;

Stuftlt Classic Preferences file (in your Preferences folder, inside the System Folder);

Help files (in the Help folder, within your System Folder);

“Optimizers” used by Stufflt Deluxe (placed into the Optimizers Folder, also within the
System Folder);

6. UnPack “Translator” (placed into the Translators Folder, also within the System Folder).

M
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It is important that you receive the entire Stufflt Classic package. If you are unsure that you have
all the pieces or the current version, contact Aladdin Systems to get the Install Stufflt Classic
application or the most recent version of the software.

Registering Your Copy

Stufflt Classic is publicly distributed as shareware. It is not a free product. You can use the
product on a trial basis for up to 15 days and if you are happy with it, you must pay a registration
fee of $25. Your registration fee entitles you to special benefits including free technical support
and special product offers. The last page of this manual contains a registration form for you to
complete and send to Aladdin Systems.

We encourage you to give the Install StuffIt Classic file to your friends so that they too may
enjoy the benefits of file compression and archiving. Of course, be sure to remind them that the
software should be registered!

Some terminology:

You should be familiar with the following terms when reading this document. Some of them
have been used already.

Archive or Stufflt archive - A document file created by Stufflt which contains other files and
folders. As a standard convention, archive names usually end in “.sit”.

Command key - A key on the keyboard that is used (alone or with another) to represent a
command. When this manual states [Command], it is referring to the cloverleaf character on
Macintosh keyboards.

Compression - The use of various mathematical algorithms in an attempt to compress files
(reduce their size) before adding them into an archive. Compressed data still retains the same
information even though it takes up less space.

Entry or an archive entry - A file which has been stuffed into an archive by Stufflt.

File - A collection of data stored on a disk. Documents and Applications are examples of files.

Folder - A holder of applications, documents, and other folders.

Read-Only - Used in this document to refer to an archive which is locked or which resides on a
volume which may not be written to, such as a CD-ROM. You can only read information
from these archives. You can’t change the information contained in such archives and you
can’t add to them.

Volume - Any permanent storage device recognized by your Macintosh, such as a floppy disk, a
hard disk, a tape, etc. In this document, volume may be used in context as the name of a
volume. (The word “disk™ is avoided because there are other devices such as CD-ROM and
WORM that can be used as storage media.)

Stufflt Classic version 1.6 Page 4



Stufflt Classic User’s Guide
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2. Creating/Opening an Archive

New Archives

Before working with a new archive, it must be created. Creating an archive is a very simple
process. In Stufflt Classic, go to the File menu and select New Archive... or type
[Command]-N. You will be prompted with a dialog box asking for the name of the archive and
the place where you want the archive to be created. This dialog works much like the Save As...
dialogs in other applications. Stufflt Classic will automatically add the letters “.sit” to the end of
the archive as a basic convention. It makes archive files easier to spot if everyone follows this
convention, however, the name is arbitrary. Enter the archive name, select the destination
volume/folder in the usual manner, and type return or click the New button.

Creating 1.5.1 Archives

At the bottom of the dialog box, there’s a checkbox that allows you to create
“1.5.1” archives. 1.5.1 is an older version of Stufflt that used a different type of
file format. The 1.6 version of Stufflt Classic can work with 1.5.1 and the newer
Deluxe archives as well. If you need to send an archive to a friend who doesn’t
have the 1.6 (or Deluxe) version of the software, check this box.

Opening Existing Archives

To work with an existing archive created by yourself or others, you must open it. Select Open
Archive... from the File menu or type [Command]-O. You will be presented with the familiar
Open dialog box as in other applications. Locate the archive you wish to open, select it and click
on the Open button.

Advanced Users

You are allowed to open archives created by Stufflt Classic and compatible
utilities as well as self-unstuffing archives. If you hold down the [Option] key
as you select Open Archive..., you can open any file. Be sure that the file you
are opening is truly an archive if you choose to do this.

Read-only Archives
If you open an archive on a locked volume or if you open a locked archive, you

will not be allowed to make any changes to that archive. (You cannot stuff more
files, rename entries, delete entries, etc.) This is called a read-only archive.
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Archive Contents Display

® File Edit Archive Other Options

MountEm™ 1.5.sit H]
G MountEm™ 1.5.sit

= Tgpe Crea Size Date Saved
() MountEm FKey(S) FKEY wpsM 5502 12/26/89 26%
) MountEm Doc ttro  tixt 7510 12/11/89 44%

Current level: 2 items, 13K decompressed.
| %] Deluxe Archive is 8K on Donatello (228474K free).

After creating a new archive or opening an existing one, you will be presented with a window
which has the name of the archive as its title. Just below the archive name is a pop-up menu that
lets you navigate within the archive folder hierarchy. An archive can just be considered another
folder on your disk which has other folders within it.

Below the pop-up menu are the headings for the contents of the archive. Clicking on any
heading will have Stufflt Classic sort the entries by that heading.

Below the headings is the area where the archive entries are displayed. If there are any entries,
the following information about the file entries should be displayed:
File/Folder Name, File Type, File Creator, Original File Size, Date Last Modified,
Percentage Saved (when compressed).

Next to each entry, you will see a small icon that represents what the entry is. You will see a
small icon of a document (as shown above), an application, a folder, or a lock (which represents

a secured entry).

At the right side of the window is a scroll bar to scroll up and down if there are more entries than
can be fitted in the window.
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At the bottom of the window are the status lines which tells you how many entries are in the
current folder level, how much space the archive occupies on the volume, and how much space
all the entries originally occupied before archiving (which is exactly equal to the space the entries
would take up if they were unstuffed and saved onto a volume) If the archive is a read-only
one, an icon of a padlock will follow at the end of this line.

The small magnet icon in the lower left will “snap” the Archive Palette to the bottom of the
window. The next chapter describes the Archive Palette.
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3. Working with Archives

There are quite a few operations which you can perform on archives. All of them can be
accessed through the Archive menu or its equivalent, the Archive Palette. The Archive Palette
contains icons that represent each command available from the Archive menu. Some of them
have keyboard shortcuts associated with them.

Stuff... S

Multiple Stuff... M

UnStuff... 3#EU

Delete 3D

Rename... #R

Info... 31 :
Comment... P@UQ@U@@U | U U [2] U \
H|de Pa|ette 38 Stuff || Multiple )| UnStuff)| Delete §| Rename Info Comm...
The Archive Menu The Archive Palette

The icons, from left to right, are: Stuff, Multiple Stuff, UnStuff, Delete, Rename, Info and
Comments. In the picture above, the Comments icon is showing a text filled “balloon”. (The
lines depict text.) This indicates that comments exist for the current archive. If the “balloon” is
empty, no comments exist. If the archive is read-only, the Stuff and Multiple Stuff icons will be
dimmed. If no entry is selected, the UnStuff, Delete, Rename and Info icons will be dimmed.

The two main operations which can be performed on archives are stuffing files and unstuffing
entries. First, we’ll discuss three methods of selecting files to be stuffed.

Stuffing Files

To stuff files to the current archive one at a time, select Stuff... from the Archive menu, click on
the Stuff icon, or type [Command]-S. You will be presented with a dialog box that is like an
Open dialog box. The only differences are that it is larger, has two “open” buttons (Open and
Stuff), and has an options area at the bottom. The options area at the bottom allows you to get
specific in designating the type of compression used when stuffing a file. The other option is a
check box labeled “Delete Item When Finished.”
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Open - After selecting a file, clicking the Open button tells Stufflt Classic to stuff that entry
to the current archive. The phrasing of the word Open may not seem intuitive, but there
is a reason for the separate Open and Stuff buttons. If a folder on a volume is selected,
clicking Open will open that folder. ([Return] is identical to the Open button in function.)

Stuff - Stuff functions identically to Open except when a folder is selected. Stuff will have
Stufflt Classic add the entire contents of the folder including all files and folders within it.
(On a U.S. Keyboard, [Command]-[Return] is identical to the Stuff button.)

Tip

It is possible to specify an entire volume to be stuffed. (This may
come in handy if you wish to stuff an entire floppy.) If no file or
folder is selected (You can deselect any selected file/folder by clicking
in the list and dragging, with the mouse button down, beyond the top
of the list), clicking Stuff will specify the entire volume. You can then
later restore the entire volume exactly as it is.

Compression - Stufflt Classic allows you to specify the compression method used when
stuffing a file. Generally, there is a direct trade off in speed versus compression - the
faster something compresses, the less compression it will get.

Stufflt Classic has labeled two types of compressions — Fast and Better. When you
select Fast Compression, you will always get the fastest compression available that will
produce the desired compression results. If you select Better compression, Stufflt
Classic will try a number of compression algorithms, making sure that you always get the
best compression no matter what. Since Stufflt Classic will try a number of compression
methods, Better may take a little while to determine which is actually the best.

A third option, Best Guess is probably the option you will always want to use. Best
Guess has Stufflt Classic use some intelligence in determining which compression
method to use. It will look at the file to determine which method to use and almost
always it will make the right choice, giving you the most compact file in the smallest
amount of time.

You can also change the compression method from the Options menu before entering the

Stuff file dialog box.

Delete Item When Finished - If this check box is checked, the file or folder being stuffed
will be automatically deleted if the stuff operation was successful. Note that this box
unchecks itself each time. You must make a conscious effort of checking it.
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Stuffing Multiple Files

As a convenience, Stufflt Classic allows you to specify up to 40 files and/or folders to be stuffed
in succession. This way, you can select all the files to compress and let Stufflt Classic do its
work.

To use this feature, select Multiple Stuff from the Archive menu, click on the Multiple icon, or
type [Command]-M. You will be presented with a large window that is split into two parts.
The left side of the dialog is like a normal Open dialog - it contains the contents of any disks you
are currently using. (It also has the compression options, just like the Stuff dialog.)

The process for using this dialog is very simple - you move files to be stuffed from the left side
to the right. When you have specified all the files, you then click on the Stuff All Items button.
The dialog contains a few other buttons to assist you in the process.

Open ([Return]) - If a file is selected, clicking Open will add it to the list on the
right. If a folder is selected, Open will enter into that folder.

Add ([Command]-[Return]) - Lets you add more files and/or folders to the
Multiple Stuff list if there are less than 40 entries on it.

Cancel ([Command]-.) - Tells Stufflt Classic that you don’t want to add the files on
the list after all.

Remove ([Command]-R) - The button below the Multiple Stuff list. If you do not
want specific items stuffed into the archive after they have been added to the
Multiple Stuff list, select them and you can have them removed from the list
with this command.

Unstuffing Files

Now that you have an archive with some entries in it, how do you retrieve those entries? Before
you can use them you must unstuff them from the archive. Once a file is unstuffed, it will be
restored to its original status on your disk, ready for use.

With an archive open, you will be looking at the contents display, as described earlier. In order to
unstuff entries, you must select the entries first.

Selecting Entries
To select a single entry, just click on it. If the entry is not in view, use the scroll

bar in the usual manner to bring it into view and then click on it. You will see that
the file/folder name will be displayed in inverse (white on black).
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To select a continuous range of entries, select the first entry in the range.
Holding down the [shift] key, select the last entry in the range. All entries
between and including the two will be selected and depicted in inverse.

To select a discontinuous group of entries (such as the first, the fourth and the
tenth), select any one entry in the group. Holding down the [command] key,
select the other entries.

Using the [command] key also allows you to de-select a selected entry or to
select another not-yet-selected entry. (If you hold down the [command] key and
click on an entry, it will be selected if it isn’t already and deselected if it is.)

Once the entries you wish to unstuff are selected, click the Unstuff... icon (or type
[Command]-U or double click on a selected entry).

You will be presented with a dialog resembling the standard Save As... dialog box for each
selected entry. Besides the usual Save button, there are also buttons labeled Save All, Skip and
Cancel.

To simply save the unstuffed entry, click on the Save button or type return. Note that the original
name will be given to you as the suggested name. You may change it before saving if you wish.

To unstuff and save all selected entries to the same location using the suggested names, click on
Save All or if you wish, type [Command]-<return>.

Should a file name conflict arise during the save all process, you will be presented with this
dialog again, allowing you to cancel or continue the unstuffing process.

Tip

There are two short cuts to help you easily unstuff all entries in an archive. If you
are opening the archive or archives from the Finder, hold down the [shift] key as
Stufflt Classic loads. All the archives you open will be processed in order. The
contents of each archive will all be unstuffed and saved into a new folder with the
name of the archive. The last archive will be left open. If you are opening an
archive from within Stufflt Classic, holding down the [shift] key as you click
Open, double-clicking, or pressing [return], after you have selected the archive
you wish to open, will accomplish the same thing.
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Progress Dialog/Aborting An Operation

As you have noticed by now if you’ve tried stuffing/unstuffing, there is a
progress dialog that illustrates how far into the current process you are. The
dialog consists of a few parts. First, a filling icons symbolizes the progress of the
entire operation, no matter what the operation is. For each file that is being
worked on, the top part of this dialog displays the name of that file and a
thermometer bar shows its progress. If Stufflt Classic is working on a folder, the
dialog will extend to show the name of the folder and a thermometer bar to
indicate its progress.

During the stuff/unstuff processes, if you hold down the [Command]-. (period)
key combination, Stufflt Classic will abort the current operation. Keep holding
down the two keys until you hear Stufflt beep at you. You can also cancel the
operation by clicking the Cancel button.

The progress dialog may be positioned anywhere on your screen by dragging the
title bar like any other window.

That’s it for stuffing/unstuffing files - the two primary functions of Stufflt Classic. There are a
few features to make it easier to work with archives and they will be discussed next.

The Delete Operation

Sometimes, it would be very convenient to be able to delete an entry from an archive. Perhaps it
was stuffed erroneously or perhaps the entry is to be replaced by a newer file. Stufflt Classic
provides such a capability.

Select the entries you wish to delete. Select Delete... from the Archive menu, click on the
Delete icon or type [Command]-D. Stufflt will present you with a dialog asking you to confirm
the deletion. Acknowledge and the entries will be deleted. To bypass the warning dialog, hold
down the [option] key while issuing the delete command.

Of course, if the archive is read-only, you cannot delete any entries from it.

The Info Operation

If you would like to know some information on the entries in an archive, select the entries you
wish to query and select Info from the Archive menu (or click on the Info icon or type
[Command]-I). You will be presented with an information window for each selected entry. If
the entry is a file, you will see the file’s original size, compressed size, creator, type,
creation/modification date and the name of the creating application.
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If the entry is a folder, you will see the total compressed and decompressed sizes of the folder as
well as a listing of the folder’s contents. You can use the scroll bar to go through the listing as
needed. Just click OK or type a [Return] when you’re done viewing the info for an entry.
Stufflt Classic will proceed to display information on the next entry you selected or if that was the
last entry, Stufflt Classic will return you to the archive contents display. At any point, you can
also click Cancel All or type a [Command]-. and you will be returned to the archive contents
display instantly. No info will be displayed on the remaining selected entries.

The Rename Operation

Stufflt Classic displays the entries of an archive with the original names. When unstuffing, it will
also suggest these as the default names. However, it is possible to change the file name without
having to unstuff the entry, delete it, rename the unstuffed file and re-stuff it. Just select the entry
or entries you wish to rename. Select Rename... from the Archive menu or click on the
Rename icon (or type [Command]-R). Stufflt Classic will go through each selected entry and
give you the opportunity to rename it. (Of course, if the archive is read-only, you can’t rename
entries!)

Archive Comments

It is possible to store some short comments along with each archive. With the archive open,
select Comments... from the Archive menu or click on the Comm... icon. You will see the
current archive comments, if any. You may change them or add them if desired. (If the archive is
read-only, you can’t add or change comments!)

Note

If the Comments icon shows an empty “balloon”, no comments exists for the
current archive. You may add some, of course. If the “balloon” is filled with
lines which represent text, then comments exist for the current archive.

Generating/Printing Reports

Stufflt Classic includes the capability to generate a report, in the form of a ‘TEXT" file, for the
current archive. The report will list some statistical information about all the entries in the
archive. Select Generate Report... from the Report menu (or type [Command]-G). You will
be presented with the familiar Save As dialog box. Indicate the name of the report file and the
location where you wish to have it saved. Once a report is generated, it may be viewed with a
text editor or a word processor. Tab spacing should be set to 8 or 16 spaces for optimal results.
The report may also be imported into a spreadsheet or a database for further cataloging.
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Just as a report can be generated to a text file, one may be printed to any printer by using the
Print Report... command ([Command]-P) under the File menu. Use the Page Setup
command (also in the File menu) to establish information about your page, prior to printing a
report. Once you are satisfied with the Page Setup options, click OK and choose Print
Report... The Print Report dialog is the same as any print dialog with the exception of a single
option at the bottom. This option lets you specify whether to print a report for the entire archive
or for the current level being displayed. After all options have been satisfied, click OK and your
report will be printed.
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4. Other Options

Creating Self-UnStuffing Archives

Stufflt Classic allows you to create archives that can be sent to people who do not have Stufflt
Classic or Stufflt Deluxe to unstuff them. These files are called self-unstuffing archives and
they’re made by first creating an archive and then attaching a “self-unstuffer” to that archive.
Combined, these two files become a double-clickable application.

There are two ways to create a self-unstuffing archive. The first, and easiest method, is to use the
Self-UnStuffer menu command. After you’ve created the archive that you want to change to a
double-clickable application, choose the Add Standard sub-menu from Self-UnStuffer (in the
Other menu). The Add Custom sub-menu option in the Self-UnStuffer menu is used install
specialized self-unstuffers to an archive. This method always turns the current archive into a
self-unstuffing one, while the next method always saves a second, self-unstuffing, version of the
archive.

The second method of creating a self-unstuffing archive is to use the Save As... command. As
you are working with the archive you want changed, choose Save As... from the File menu. At
the bottom of the Save As... dialog dialog will be Create Self-UnStuffing Archive pop-up
menu. Simply select Standard from this pop-up menu, type a new name for your file and click
Save. In a few moments, a self-unstuffing archive will be saved to disk. Another option,
Custom, is also available from the pop-up menu; it is used like the Add Custom sub-menu
described above.

Any time you wish to remove the self-unstuffer from an archive, open the archive and select
Remove from the Self-UnStuffer heirarchical menu. When this is done, the archive will no
longer be a doule-clickable application and can be used just as any other archive.

Software developers, publishers, VARs, and other types of vendor who wish to distribute
software in a self-unstuffing format need to have a license from Aladdin Systems. With a
license, Aladdin will send you a custom self-unstuffer for your distribution. Aladdin also
provides other types of installers and self-unstuffers that work across multiple disks and perform
other tasks (such as installing software in a specified location). Contact Aladdin Systems for
more information.

Sorting archives

For easier display, you can simply sort the listing of the contents of an archive. At the top of
each column within an archive window are the column headings. By clicking on the appropriate
heading, the archive will be sorted. For example, if you want the archive sorted by Type, click on
the heading Type and it will be sorted.
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Preferences

Under the Edit menu, the Preference menu choice lets you specify some options about how
Stufflt Classic operates. You can customize these settings to your own specifications.

Preferences
- General Options: r Archive Menu Options:
B Allow Background Tasks [] Iconic Archive Menu

(<] Restore Modification Dates
(<] Sounds When Finished
[(J Conv. 1.5.1 Archives on Open

r Yirus Detection Options:
) All (Both Viruses and Anomalies)

{® Known Viruses Only
New Folder Suffix | Folder ) Off

- Folder Stuffing Options :
{) Stuff as separate files

{) Ask the user what to do

@ Stuff as whole folders

Allow Background Tasks

If MultiFinder™ is running and this option is checked, Stufflt Classic will delegate time
to MultiFinder background tasks, such as the Print Monitor, during the stuffing and
unstuffing processes. Stufflt Classic has a lot of computations to do when compressing
files. Thus, it will give very little time to the new foreground task. If you have a speedy
machine, it may be enough.

Restore Modification Dates

If checked, Stufflt Classic will restore the modification dates of files unstuffed from an
archive. This is usually what you want unless you have a hard disk backup program
which relies on modification dates for incremental backups. In such a case, if the
modification dates are restored, the program may not back up the unstuffed file.

Sounds When Done
When stuffing or unstuffing large files, you may want to leave your Macintosh for a

while. With this option checked, Stufflt will sound for you when it’s done and ready for
your next commands.
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Convert 1.5.1 Archives on Open

1.5.1 is an older version of Stufflt that used a different file format. This option allows
you to automatically convert the older files to the newer format upon opening them up.
With the new format you can, among other things, use the best compression available.

Folder Stuffing Options

The three options dealing with folders determines what Stufflt Classic will do
when asked to stuff a folder. They are provided primarily for longtime users of
Stufflt who are used to one setting. It is best that you leave it set for Stuff as
whole folders.

Stuff as separate files means that Stufflt Classic will never stuff a folder as a
folder. The folder’s contents will be stuffed as separate files and each of these
files will be a separate entry in an archive.

Stuff as whole folders means that the entire folder will be stuffed and its
contents will be maintained in a hierarchical fashion, just like it was on disk.

Ask the user what to do means that Stufflt Classic will put up a dialog box each
time you request a folder to be stuffed. The dialog box will offer you a choice
between files and folders. To select what you want, click on the appropriate
button or type F for files or H for hierarchical folders.

Iconic Archive menu

Instead of using words (just like every other menu), Stuffit Classic has the option where
the same icons shown in the Archive Palette can be displayed in the Archive menu.

Virus Detection Options

Stufflt Classic has the ability to detect viruses as files are being stuffed or unstuffed from
an archive. Viruses are a very serious matter and since Stufflt Classic only detects the
ones that are current as of this manual, we STRONGLY RECOMMEND that you
purchase a virus eradication utility.

There are three options for virus detection within Stufflt Classic. All (viruses and
anomalies) will find current viruses as well as unusual situations (damaged files, etc.).
This option will also find new strains of certain, current viruses. Known Viruses Only
will find viruses that are current as of the release of the software. As of this manual,
these viruses include Scores, nVIR-A, nVIR-B, Hpat, AIDS, MEV#, nFLU, INIT29,
ANTI, MacMag (also known as Drew, Brandow, and Peace), WDEF-A, WDEF-B,
ZUK, MDEF, CDEF and MDEF2. If you do not wish to have any virus detection, select
Off from this dialog.

Stufflt Classic version 1.6 Page 18



Stufflt Classic User’s Guide

Obtaining Help

Stufflt Classic has a built-in help system (also referred to as online documentation) that
can assist you in quickly getting assistance on using the features of Stufflt Classic. There
are two ways to get to the help window; the first is to simply select Help from the Apple
menu. The second is to type [Command]-? from the keyboard and then select the menu
item you want help on.

The help window is divided into three parts: the Topic List, the Go Back icon, and data
area. The Topic List displays the list of information that is available within the help
window. Each topic is shown in the data area, which is fashioned after a page. The data
area consists of text and/or pictures and a dog-ear for “flipping” between pages. Some
text and pictures also serve as “hot areas.” The hot areas either display more information
or link you to other topics. You can determine the hot areas on any page by holding
down the [spacebar]. Also shown at the bottom of each page are “See Also” topics,
which take you to that page. Lastly, the Go Back icon displays a pop-up menu which
allows you to quickly jump to a set of common topics as well as the last ten topics you
have viewed.
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5. Segmenting Files

Stufflt Classic provides a general purpose facility for segmenting large files into parts (segments).
You may want to do this in order to fit a large file from a hard disk onto floppies or to send a
large file in chunks over a communications link.

Begin by selecting Segment... from the Other menu. Prior to selecting a file to be segmented,
use the pop-up menu at the bottom to specify the size of the segments. If you do not wish to split
the file into pieces that will fit onto a specified diskette, choose Other... from this menu. When
choosing Other, you will be presented with a scroll bar that works in 5 kilobyte increments from
5K to 3000K.

After you have selected the proper size, select the file and click on the Segment button. For each
segment of the file, you will be prompted for the name and location (to save) for that segment. If
you want the segments on multiple diskettes, insert them at each time you are asked for each
segment. After the final segment is saved, the segment operation will be complete. You will
have the segments of the original file. You must have all the segments to be able to recreate the
original file at a later date or in a different location.

Joining Segments
Now, if you have all the segments of a file, they must be joined back together in order to recover
the original file. Select the Join... command from the Other menu. You will be asked to find

the first segment. Do so. You will be asked to find each of the other segments in sequence. Do
so and the join operation will be complete. You will have the original unsegmented file.
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6. UnPack

For compatibility purposes, Stufflt Classic supports files created by the Packlt II and Packlt I11
compression utilities (as long as encryption wasn’t used.) Stufflt Classic is noticeably faster at
UnPacking than Packlt.

To UnPack a .pit ( Packlt files usually have the “.pit” suffix) file, select UnPack from the Other
menu. Find the file you wish to UnPack. For each entry, you will be prompted as to what to
name the file and where to save it. (Or, if an archive is open, you can have it converted to the
Stufflt format.) You can use Save All and Convert All to save all remaining entries using the
default name to the same location or to convert all remaining entries, respectively. You may also
skip an entry or entries. Note that due to a design oversight in Packlt, skipping requires the
actual decompression of the entry and is thus not very fast.

Packlt was written by Harry Chesley.
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7. BinHex

BinHex4’s .hgx is a standard used to convert Macintosh binary files to an ASCII format
primarily for transmission over channels that do not support binary data, like ARPAnet and
Usenet mail/mews. Stufflt Classic allows you to both encode and decode BinHex4 files.

Encoding

Under the BinHex hierarchical menu (under the Other menu), select the Encode BinHex
File.... Select the file to encode. Name the resulting file and select the destination. As a
convention, BinHex4 files usually have the “.hgx” suffix

Decoding

Decoding works the same way. (Of course, use the Decode BinHex File... command instead of
encode.)

Include LFs

On some systems the mailing of .hgx files may not be reliable unless linefeeds are included in
addition to carriage returns. If this option is checked, Stufflt Classic will include linefeeds when
encoding BinHex4 files.

Technical Note

Stufflt Classic does not perform RLE encoding on BinHex4 files. It will decode
it, though. Thus, Stufflt Classic may encode .hgx files to a size slightly larger
than BinHex4 does. However, BinHex4 can decode the files and Stufflt Classic
can decode .hgx files with RLE.
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A. Legal Information

Commercial distribution of Stufflt Classic and self-unstuffing archives is restricted and requires a
license from Aladdin Systems. We are more than happy to allow you to distribute our software,
but you must first have a license to do so. Contact Aladdin Systems for details on obtaining a
license.

Disclaimer of Warranty and Limited Warranty

The software and accompanying instructions for use are provided “as is” without warranty of
any kind. Further, Raymond Lau and Aladdin Systems do not warrant, guarantee, or make any
representations regarding the use, or the results of the use of the software or accompanying
instructions in terms of correctness, accuracy, reliability, currentness, or otherwise. The entire
risk as to the results and performance of the software is assumed by you. If the software or
instructions are defective you, and not Raymond Lau or Aladdin Systems or its dealers,
distributors, agents, or employees, assume the entire cost of all necessary servicing, repair or
correction.

Aladdin Systems warrants that the disks on which the software is recorded is free from defects in
materials and workmanship under normal use. You may obtain a replacement disk by returning
the original disk to: Aladdin Systems, Inc., Deer Park Center, Suite 23A-171, Aptos, California,
95003, United States of America, (408) 685-9175.

Aladdin Systems entire liability and your exclusive remedy as to the disk shall be, at Aladdin
Systems option, either (a) return of the purchase price or (b) replacement of the disk that does not
meet Aladdin Systems’ Limited Warranty.

The above are the only warranties of any kind, either expressed or implied, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose that are
made by Aladdin Systems on this Aladdin Systems product. Neither Aladdin Systems nor
anyone else who has been involved with the creation, production, or delivery of this product shall
be liable for any direct, indirect, consequential, or incidental damages even if Aladdin Systems or
an agent of Aladdin Systems has been advised of the possibility of such damages.
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U.S. Government Restricted Rights

The software and documentation is provided with RESTRICTED RIGHTS. Use, duplication, or
disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of
The Rights in Technical Data and Computer Software clause at 252.227-7013. Manufacturer is
Aladdin Systems, Inc., Deer Park Center, Suite 23A-171, Aptos, California.

Trademarks & Copyrights

Apple, Macintosh and MacWrite are registered trademarks of Apple Computer, Inc.
Finder ,MultiFinder, and PrintMonitor are trademarks of Apple Computer, Inc.

The names, words and likeness of Stufflt, Stufflt Classic, Stufflt Deluxe, UnStufflt, Stufflt, sit, .sit
and unsit; the Stufflt, Stufflt Classic, and Stufflt Deluxe logos, and the phrase, “The Macintosh
archive utility” are trademarks of Raymond Lau and/or Aladdin Systems, Inc. and may not be
used without written permission from Aladdin Systems.
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5. Registration/Order Form

Name

Company

Address

City State

Zip Country

Phone ( ) -

Product Quantity Price Amount
StuffIt Classic™ (Shareware Registration) s25.00
StuffIt peluxe® s99.95
shortcut™ s79.95
Programmers Assistamts™® s99.95

Sub Total

Tax (NY & CA only)

Shipping (add $5 in US, $15 overseas, Except for StuffIt Classic)
Total

Send More Information: _ StuffIt Deluxe _ Shortcut _ Developer Tools
__Site Licenses _ Installation Licenses

__ Other

Payment

Visa/Mastercard # - - - Exp Date

Check/Money Order Purchase Order #

Cash

Signature Date

Mail to:

Aladdin Systems, Inc.

Deer Park Center

Suite 23A-171

Aptos, CA 95003

United States of America **%x* THANK YOU FOR SUPPORTING SHAREWARE! ***%
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